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Abstract

A panel of customers who are running IBM CICS Transaction 
Server V5.1 (CICS TS 5.1) will discuss their experiences in 
migrating to and using CICS TS 5.1. IBM will also discuss 
some experiences with the CICS beta(s) and other customers 
who are running CICS TS 5.1. Come and hear the story from 
those who have been there, done that.
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Disclaimer

Standard disclaimers apply.  Any opinions expressed are the 
opinion of the author only.  Any mentioned brand names, 
trademarks, registered trademarks, service marks, etc., are 
the exclusive property of their owners.  No warranties are 
either expressed or implied, your mileage may vary, etc.



4

Agenda/Topics

● Introduction
● New CICS version “Opportunities”
● Why participate in a CICS Beta?
● Why migrate from CICS TS 4.2 to 5.1?
● ISV Program Products and Early Support Issues
● CICS TS 5.1 Installation/Migration Considerations
● Summary and Q&A
● Appendix and Additional Information
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Introduction (cont.)

● Founded in 1853, became the University of Florida in 
1905.  (East Florida Seminary -> Florida Agricultural 
College ->  University of Florida) 

● UF is a member of the AAU, the Association of American    
Universities.

● UF is one of the top five largest universities in the U.S., 
public or private.

● ~50K enrolled and ~250K alumni.
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Introduction

● UF CNS, University of Florida Computing & Networking 
Services  (formerly known as NERDC), runs the primary UF 
networking and data centers in Gainesville, FL

● Currently utilizing an IBM DS8800 and z114 2818-M05 
Q02/S02 with 32GB and a zIIP, running z/OS 1.13 (with 
zAAP on zIIP enabled), CICS TS 5.1 and 4.2, DB2 10, 
RACF, JES2, etc. 

● 3 LPARs - 1 internal "sysprog sandbox", 1 test  
"alternate", and 1 production or "primary"

● IBM z114 + DS8800:
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Introduction (cont.)

● We're considered a "Classic" CICS site.                              
("Legacy = It Works!") 

● Web access to CICS is via the CICS Socket Interface, in use at 
our site since ~1997.

● Currently, up to ~90% of local CICS tasks utilize sockets.
● All locally developed CICS applications are Assembler and/or 

COBOL.  We have ~8K CICS application load modules, and ~32 
have CICS sockets API (for file/data transfer, email, web 
enablement, etc.).  

● Several internal CICS applications written in C/C++ and REXX.   
Java has only been IVP tested, but with our z114 and z/OS 
zAAP on zIIP, we're looking at exploiting Java, and/or PHP, 
and/or Groovy and/or ??? in CICS in the future. 
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Introduction (cont.)

● Are we now considered a Nouveau CICS site?
● CICS Web Services (WS) in production since Sept. 2006
● 11 CICS WS in production (all using HTTP transport protocol)

● 5 CICS Provider WS
● 6 CICS Requester WS

● CICS WS technology has been rock solid and a good performer at our 
site

● IBM supplied CICS WS assistant tooling has met all of our needs so far
● Eclipse Web Services Explorer has also been utilized for testing

● Conforms to open standards such as HTTP 1.1, SOAP 1.2 and 1.2, 
WSDL 1.1 and 2.0

● Ensures maximum interoperabilty
● UF utilizes MS BizTalk as a messaging hub
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Introduction (cont.)

● We have 9 CICS regions configured and run ~400K 
production transactions/weekday and ~1.1M on peak load 
days (start of academic semester term)

● 2 internal test/sandbox, 2 development/test, 3 
test/QA/staging, and 2 production CICS regions currently 
configured

● By 28JAN2013, 6 out of our 9 configured CICS regions 
were running the CICS TS 5.1 GA code 

● Due to the UF academic schedule, the remaining regions 
will be converted to CICS TS 5.1 in the very near future
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Introduction (cont.)

● We anticipate 100% (or very near 100%) scheduled availability with 
CICS TS 5.1, and exceptional performance, especially coupled with our 
phenomenal IBM z114 (with a zIIP) and DS8800

● We plan on performing extensive load testing with LoadRunner and 
CICS TS V5.1 vs V4.2 scenarios (as we did with CICS TS V4.1 vs 
V4.2)

● Schedule dependent upon application developers/analysts, load 
test team members and academic schedule timing

● IBM says:
● Performance considerations

● Performance information is available in the Performance Guide 
(SC34-2864), from general availability. In addition, at a later 
date, a performance report will be available on request from 
your IBM representative.
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Introduction (cont.)

● CICS Transaction Server for z/OS V5.1 (CICS TS 5.1) was 
announced October 3, 2012 (ENUS212-325.PDF)

● CICS TS 5.1 was Generally Available (GA) on December 
14, 2012

● Over 100 customer and user group requirements satisfied
● Participation in SHARE and the CICS beta(s) helps 

expedite CICS requirements processing and prioritization
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Introduction (cont.)

● UF was invited to participate in the IBM CICS TS 5.1 
"Managed" (vs "Open") Beta in October, 2011

● z/OS V1.12 was minimum OS level at Beta start, with z/OS 
V1.13 the minimum at GA

● Downloaded first code drop ("Beta #1") on November 10, 
2011

● “Odd” numbered and GM (Gold Master) code drops 
(iterations) to CICS customers, with all code drops to CICS 
ISVs in this Beta
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Introduction (cont.)

● CICS TS 5.1 Managed Beta time line:
● Beta #1 November 2011
● Beta #2 February 2012 (ISVs)
● Beta #3 March 2012
● Beta #4 May 2012 (ISVs)
● Beta #5 July 2012 (expire date 31JAN2013 - 

“Open Beta”)
● Beta #6 September 2012 (ISVs)
● Beta #7  October 2012 (Open Beta Refresh)
● GM November 2012 “Gold Master”
● 0680 (GA) December 14, 2012 

● How does one know which code drop is installed and/or executing? ;-)
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New CICS Version “Opportunities” 

● What's New?  IBM says:
● “CICS® Transaction Server for z/OS®, Version 5 

Release 1 delivers a set of new and enhanced 
capabilities in a way that positions CICS users for the 
next era in technology, moving them towards a service 
delivery platform for cloud computing.”

● “CICS TS V5.1 satisfies over one hundred customer 
requirements that help solve the two most pressing 
challenges that companies face today; driving  
operational efficiencies, while increasing service agility.”
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New CICS Version “Opportunities” 
(cont.)
● Financial

● State of Florida budget
● University of Florida budget
● Price increase (9% at our site)

● Political
● Continued push to migrate off of the mainframe (“eliminate 

costly mainframe technologies”)
● Resources

● Time (keeps on slipping, slipping, slipping, into the future)
● Other “projects” such as password phrases, CBU, etc.

● People
● Retirement(s), etc.
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New CICS Version “Opportunities” 
(cont.)
● CICS TS V5.1 order justification (upgrade/migration) letter

● Recommendation to management to continue to invest in our 
core UF Student Application server/transaction processing 
infrastructure – CICS!

● Maintain currency
● CICS TS V4.2 EoS 3rd Quarter 2017 per IBM 

● New dynamic CICS SVC update (DFHCSVCU utility)
● New PERFORM SSL REFRESH command
● New threadsafe enhancements

● Includes CICS Transient Data (TD)
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New CICS Version “Opportunities” 
(cont.)
● CICS TS V5.1 order justification (upgrade/migration) letter

● New application policy management
● Send a message, and/or abend, and/or invoke non-

intrusive CICS event(s)
● Possible local use case scenarios discussed

● Collateral (attachments)
● CICS TS V5.1 Announcement Letter
● CICS TS V5.1 Presentation Slides
● CICS TS V5.1 Software Price Quote from IBM System z 

Software Business Partner 
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New CICS Version “Opportunities” 
(cont.)
● IBM CICS TS V5.1 and prior provide 32-bit CICS Information 

Center downloads for Windows and Linux
● New Slackware Linux 14.0 installs “pure” 64-bit w/o 32-bit 

support (but available if needed/desired)
● Workaround in CICS TS V5.1 Information Center home:

● mv jre jre.000
● ln -s /usr/lib64/java jre  

● sfw@sfw-x220:~/cics/cicsts51/ga/ic$ java -version

java version "1.7.0_11"

Java(TM) SE Runtime Environment (build 1.7.0_11-b21)

Java HotSpot(TM) 64-Bit Server VM (build 23.6-b04, 
mixed mode)
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New CICS Version “Opportunities” 
(cont.)
● IBM CICS TS V5.1 and prior provide 32-bit CICS Explorer (and 

Explorer SDK) downloads for Windows and Linux
● New Slackware Linux 14.0 installs “pure” 64-bit w/o 32-bit 

support (but available if needed/desired)
● Workaround is to only run CICS Explorer SDK V5.1 in Eclipse for Linux 

● http://ibm.com/cics/explorer -> download ->

“You want to upgrade to CICS Explorer V5 SDK”

1.  In your Eclipse IDE2 add URL 
http://public.dhe.ibm.com/software/htp/cics/updates/

portfolio/5.1/5.1.0/ to

   Window > Preferences > Install/Update > Available 
Software Sites

   2.  Update your installation using Help > Check for updates
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Why participate in a CICS beta?

● Interested in new CICS TS V5.1 
features/function/exploitation:

● Greater Capacity 
● Managed Operations
● Increased Availability
● Deeper Insight
● First-class Applications/Platforms
● Modern Interfaces
● Foundational Enhancements
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Why participate in a CICS beta? (cont.)

● According to IBM, the objectives of the managed beta program are: 
● To give IBM Customers early access to the new function in CICS TS V5.1 

and associated CICS Tools products 
● To enable customers to prepare CICS to work with complimentary products 

(ISVs) for "day one" support of CICS TS V5.1 at its general availability 
● To assist Marketing and Strategy in satisfying customer requirements 
● To ensure that the code functions as designed and developed 
● To validate the ease of use of the documentation and Help 
● To enable customers to provide direct input to development, marketing, 

and sales on current features, deployability and performance 
● To test the code in various and unique development environments 
● To assist with validation of the product's General Availability (GA) readiness 
● To identify early adopter reference accounts willing to speak to press and 

analysts 
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Why participate in a CICS beta? (cont.)

● Win-win knowledge transfer for IBM and Customers:
● “Fun?”, but lots of hard work for IBM, ISVs and customers
● Customers learn details about CICS and new release
● IBM learns details about customer needs and future 

requirements
● Future release enhancements discussed and prioritized
● CICS bugs and/or customer errors quickly resolved
● Beta process enhancements discussed and prioritized
● Encourage balance between "Classic" CICS and "New" CICS
● Encourage ISVs to have products ready at CICS GA
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Why participate in a CICS beta? (cont.)

● CICS Managed Betas very modern and efficient:
● Web-based IBM and customer discussion forum (195 threads 

and 715 posts as of 18JAN2013)
● Web-based education (travel not required, but Hursley is a 

very nice place to visit ;-) 
● Internet downloads for everything - CICS code, CICS 

Information Center, CICS Explorer, etc.
● Iterative/agile development process is excellent
● Quick and easy CICS SMP/E installation procedures, 

especially with the IBM provided DFHISTAR (CICS 
Installation Start) tool
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Why participate in a CICS beta? (cont.)

● Provide current and modern CICS mainframe environment 
at UF:

● Attempt to never say never to customer needs and 
requirements

● SOA/Web Services becoming more important at UF
● Showcase benefits of CICS and the Mainframe
● Very easy/trivial migration from CICS TS 4.2 to 5.1, 

especially after installing CICS TS 5.1 six times ;-)
● All existing local applications are running unchanged in CICS 

TS 5.1
● All CICS URMs, exits, etc., were rebuilt as with all new CICS 

version/release installs
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Why migrate from CICS TS 4.2 to 5.1?

● Interested in new CICS TS V5.1 
features/function/exploitation:

● Greater Capacity 
● Greater use of 64-bit storage and reduced usage of 24-bit 

storage
● Greater application parallelism – threadsafe API and SPI 

extensions
● Greater system parallelism through optimized Task Control 

Block (TCB) usage
● Greater Java performance improvements from 64-bit Java 

support
● Greater access to 64-bit application storage when using 

Assembler programs – AMODE(64) – non-LE Assembler only
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Why migrate from CICS TS 4.2 to 5.1? 
(cont.)
● Interested in new CICS TS V5.1 

features/function/exploitation:
● Increased Availability

● Upgrade CICS versions and releases without a reIPL with new 
DFHCSVCU utility for DFHCSVC

● New PERFORM SSL REBUILD command to refresh SSL certs 
without a CICS restart

● IPIC connections up and running during periods of inactivity
● Best practices reflected with updated and simplified defaults
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Why migrate from CICS TS 4.2 to 5.1?
(cont.)
● Interested in new CICS TS V5.1 

features/function/exploitation:
● Managed Operations 

● Ability to control critical resource thresholds with policies
● Data access – SQL or files 
● Storage
● CPU
● Manage with messages, abends, or event creation

● CICS bundles that contain policies can be packaged into 
application bundles

● Various deployment and scope scenarios
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Why migrate from CICS TS 4.2 to 5.1?
(cont.)
● Interested in new CICS TS V5.1 

features/function/exploitation:
● Deeper Insight

● Auditing of SPI commands (system configuration changes)
● Cipher suites used for SSL connections in performance data
● Calculate the actual and potential use of System z specialty 

engines such as zIIP and/or zAAP (or zAAP on zIIP)
● Requires fix for z/OS 1.13 APAR OA38409 and IBM System 

z9 or later
● And of course, lots more!
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ISV Program Products and Early Support      
 Issues

● IBM Tivoli OMEGAMON for CICS development had latest CICS 
iteration toleration code within days of new CICS beta iterations 
and generally available toleration code in the standard IBM 
SMP/E maintenance stream even before CICS TS 5.1 GA

● We're running OMEGAMON XE for CICS on z/OS V420 
("Classic" interface) 

● A “Migration Contributor” - Thanks!
● CA InterTest for CICS development had code packaging issues 

and we were unable to test before CICS TS 5.1 GA
● Code was made available the week of GA
● Used extensively by our local CICS application developers
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ISV Program Products and Early Support    
 Issues - What issues? (cont.)

● We have a CICS command level based product that has never 
had CICS release migration issues, and again, none with this 
release

● We're RACF, and had no ESM related issues ;-)
● As usual, be sure to check with all of your CICS ISVs
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Migration Considerations

● Order/installation considerations:
● Ordered on 02JAN2012 via IBM ShopzSeries, ~09:00
● Specified "Internet Delivery" – CBPDO

● Included routing to our IBM System z Business Partner
● Included our UF IBM System z Purchase Order #

● New version – Purchase Order info. required
● Available for download 03JAN2013, ~15:16
● Took under 3 hours from “secure” download to first local 

internal region running CICS TS 5.1 GA  
● Used DFHISTAR type install, with SMP/E RECEIVE 

FROMNETWORK
● Easiest/smoothest CICS install ever!   
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Migration Considerations (cont.)

● Regarding “Took under 3 hours from “secure” download to first 
local internal region running CICS TS 5.1 GA”:

● Have a good plan, and execute it well!
● z/OS (MVS) and related intergration work done in advance:

● prefix.PARMLIB updates for a new CICS
● authorized libraries, etc.
● zFS datasets built and mounted to z/OS Unix
● RACF profiles updated in advance
● Dataset naming conventions/disk space ready, etc. 

● CICS TS V5.1 Program Directory and Information Center 
review

● Beta installation practice helps make perfect!   
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Migration Considerations

● Order/installation considerations:
● “Secure” download considerations

● IBM ShopzSeries service and product orders now include two SMP/E 
RFN (Receive From Network) job JCL samples:

● RFNJOB.TXT
● RFNJOBS.TXT   <--- secure/TLS

● However, default is:
● SECURE_CTRLCONN   CLEAR    ; Commands may be clear 

(unencrypted).
● Changed it to:

● SECURE_CTRLCONN   PRIVATE    ; Commands must be 
encrypted.

● RFNJOBS.TXT also has:
● SECURE_DATACONN   PRIVATE  ; Payload must be encrypted.
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Migration Considerations (cont.)

CICS TS 5.1 Order Details:

          SOFTWARE                                                                             
          Site ID:           ##########                                                                  
          Customer No.:      ##########                                                                   
          IBM Order No:      ##########                                                                   
              
          BOX: 0 of 0                                                                                     
              
 _____________________________________________________________________________________________________    
              
 Type           Program        Mat. ID         Title                                               Qty    
              
 _____________________________________________________________________________________________________    
              
 Supply         5751CS3        5751CS3         MVS Custom-Built PDO (CBPDO)                          1    
 Supply         5751CS3        5751CS3         MVS Custom-Built PDO (CBPDO)                          1    
 Supply         5751CS3        S00WNBB         MVS CBPDO - CICS Subsystem v1.01.00,ENU,    0100      1    
 Supply         5751CS3        S0175VX         CICS TS for z/OS v05.01.00,MUL,CST3590-1    0100      1    
              
 _____________________________________________________________________________________________________    
              
                            Process Date:           2013-01-03                                            
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Migration Considerations (cont.)

CICS TS 5.1 Order Details:

Software Order                             
______________________________________________________________________________ 
Ref. No.        Description                                               Qty. 
______________________________________________________________________________ 
            
                Electronically delivered media                                 
                                        
564612          CB ELC ORDER ITEM
  
                Electronically delivered publications
GI13-0594-00    CICS TS for z/OS V5.1 Program Directory   Mat.S0175VX        
GI13-3302-00    CICS TS for z/OS V5.1 Info Center Flyer   Mat.S0175VX       
GI13-3303-00    CICS TS for z/OS V5.1 Tech Serv Flyer     Mat.S0175VX        
GI13-3304-00    Integ Sol for Sys z Devt Solution Brief   Mat.S0175VX        
GC34-2919-00    CICS TS for z/OS V5.1 LPS CD              Mat.S0175VX
                Total electronically delivered media:                       1  
                Total electronically delivered publications:                5 
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Migration Considerations (cont.)

● Review CICS TS 5.1 Information Center -> Upgrading -> 
Upgrading from Version 4 Release 2 (or 4.1 or 3.2 or prior 
CICS Information Center(s)) 

● z/OS 1.13 is minimum required for CICS TS 5.1
● Java 7 (64-bit) required for CICS TS 5.1 - note that our CICS TS 

4.2 regions run with Java 6 (64-bit) - requires 2 Java 
installs/paths in z/OS Unix

● MEMLIMIT=6G is minimum requirement (was 4G in 4.2)
● JOB statement or EXEC statement for CICS (DFHSIP)
● z/OS PARMLIB SMFPRMxx or system default
● z/OS IEFUSI exit     
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Migration Considerations (cont.)

Review SIT changes, noted in the CICS Information Center:
CICS Transaction Server for z/OS, Version 5.1 > Upgrading > Upgrading 
from Version 4 Release 2 > Changes to CICS externals > Changes to 
system initialization parameters
● New SIT parameters:

● RACFSYNC={YES|NO}
● The RACFSYNC system initialization parameter specifies 

whether CICS listens for type 71 ENF events.
● SECVFYFREQ={NEVER|USRDELAY} 

● The SECVFYFREQ system initialization parameter specifies 
whether or not CICS makes a full verification request at least 
once a day for each user ID that is used to log on to the CICS 
region.
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Migration Considerations (cont.)

Review SIT changes:
● Changed SIT parameters (with lots of new defaults!):

● AKPFREQ={4000|number}
● AUTORESETTIME={IMMEDIATE|NO|YES} 
● EDSALIM={800M|number}
● ICVTSD={0|number} 
● MXT={500|number}
● PRTYAGE={1000|value}
● SPCTRxx={(1,2 )|(1[,2][,3][,4])|ALL|OFF} 
● STATINT={010000|hhmmss } 
● STATRCD={OFF|ON} 
● STNTRxx={1|(1[,2][,3][,4])|ALL|OFF} 
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Migration Considerations (cont.)

Review SIT changes:
● Changed SIT parameters (continued): 

● TBEXITS=([name1][,name2][,name3][,name4][,name5][,name6])
● TCTUALOC={BELOW|ANY} 
● TRANISO={NO|YES} 
● TRTRANSZ={1024|number-of-kilobytes} 
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Migration Considerations (cont.)

Review SIT changes:
● Obsolete SIT parameters:

● EJBROLEPRFX
● IIOPLISTENER
● JVMCCSIZE
● JVMCCSTART
● JVMLEVEL0TRACE
● JVMLEVEL1TRACE
● JVMLEVEL2TRACE
● JVMUSERTRACE
● MAXJVMTCBS
● MAXOPENTCBS
● MAXXPTCBS
● TDSUBTASK
● XEJB
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Migration Considerations (cont.)

Specific 4.2 to 5.1 considerations:
● We run all 4.2 and 5.1 regions with a single 5.1 CSD, and 

maintain the CSD from a 5.1 region and/or 5.1 DFHCSDUP 
(starting with the GM or "Gold Master" 5.1 code)

● Our current CSD migration strategy is simply
● IDCAMS backup (DELETE/DEFINE/REPRO) 5.1 DFHCSD 
● IDCAMS DELETE/DEFINE 5.1 DFHCSD
● IDCAMS REPRO 4.2 DFHCSD into 5.1 DFHCSD
● DFHCSDUP UPGRADE REPLACE 5.1 DFHCSD
● Note:  RDO compatibility group DFHCOMPF required in 5.1 CSD 

for 4.2 regions 
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Migration Considerations (cont.)

Specific 4.2 to 5.1 considerations:
● Built new CICS TS 4.2 DFHGCD, DFHLCD, DFHLRQ, 

DFHHTML, DFHBRNSF, DFHPIDIR, and FILEA datasets. 
● Reused CICS TS 4.2 DFHAUXT, DFHDMP, DFHTEMP, and 

DFHINTRA datasets.
● A recommendation is that all new datasets be utilized for all new 

CICS releases, if possible.
● A recommendation is that SIT override START=INITIAL be 

utilized if/when switching back and forth between CICS releases 
during testing.
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Migration Considerations (cont.)

Specific 4.2 to 5.1 considerations:
● RACF (ESM) changes for new Category 1 (never associated with 

a terminal), Category 2 (initiated by a terminal user), and 
Category 3 (exempt from security check)

● See "Security for CICS-supplied transactions" in the CICS 
Information Center, and review prefix.SDFHSAMP members 
DFH$CAT1 and DFH$CAT2

● Standard migration considerations - will need review and/or 
customization by the z/OS and/or CICS RACF (ESM) security 
administrator(s)  
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Migration Considerations (cont.)

CICS TS 5.1 FMIDs, COMPIDs, and RETAIN Releases:
From the CICS TS 5.1 December 2012 Program Directory GI13-0594-00:

                                                      RETAIN 
FMID     COMPID     Component Name            Release
-------  ---------  --------------------------------  -------
HCI6800  5655Y0400  CICS TS Base 800
JCI6801  5655Y0400  COBOL Language Parts 801
JCI6802  5655Y0400  PL/I Language Parts 802
JCI6803  5655Y0400  C Language Parts 803
JCI680D  5655Y0400  Java 80D
JCI680L  5655Y0400  WAS Liberty Profile Web feature     80L  
JCI680M  5655Y0400  CICSPlex System Manager  80M
JCI680W  5655Y0400  WS-Security 80W
HCIZ300  5655M1502  Service Flow Runtime 300
H0B5110  565508700  CICS REXX Runtime Facility 110
H0B7110  565508600  CICS REXX Development System 110
H0Z2110  565511200  CICS REXX Common for CICS/ESA 110
                    CICS Explorer Feature 
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Migration Considerations (cont.)

PSP (Preventive Service Planning) UPGRADE CICSTS51:

UPGRADE  SUBSET Description
CICSTS51 HCI6800 CICS TS Base

JCI6801 COBOL Language Parts
JCI6802 PL/I Language Parts
JCI6803 C Language Parts
JCI680D Java
JCI680L WAS Liberty Profile Web feature
JCI680M CICSPlex System Manager
JCI680W WS-Security
HCIZ300 CICS Service Flow Runtime
H0B5110 CICS REXX Runtime Facility
H0B7110 CICS REXX Development System
H0Z2110 CICS REXX Common for CICS/ESA
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Migration Considerations (cont.)

●OMEGAMON toleration support for CICS TS 5.1:    
https://www-01.ibm.com/support/docview.wss?uid=swg1OA40817 

● CICS/TS 5.1 TOLERATION SUPORT
● Also see OA40818 and especially OA41081

● CA-InterTest for CICS support information:                                             
https://support.ca.com/irj/portal/anonymous/solndtls?
aparNo=GI93444&os=OS&actionID=3

*Support for CTS 5.1 is provided with the following Maintenance:

*     CICS68

*CBA8568 RO53337  CBA8500 RO53331

*CSA8568 RO53357  CSA8500 RO53351

*CLQ8568 RO53350

*CBQ8568 RO53344  CBQ8500 RO53338 
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Summary

● DFHSI1517 - Control is being given to CICS!
● Participation in CICS TS 5.1 "Managed Beta" a great 

experience
● Lots of work, but very educational and rewarding - very 

highly recommended
● With CICS TS we've enjoyed 99.999% ("five nines") 

scheduled availability.  Same for z/OS - more of the same 
for our IBM System z and prior zSeries hardware

● Migration to CICS TS 5.1 from 4.2 very quick and easy
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Appendix and Additional Information

● IBM Software -> Host Transaction Processing -> CICS   (Customer 
Information Control System):

● http://www.ibm.com/cics 
● CICS TS 5.1 Information Center (select Library from above, or):

● https://publib.boulder.ibm.com/infocenter/cicsts/v5r1/index.jsp
● IBM CICS Beta and Early Test Programs:

● http://www-01.ibm.com/software/htp/cics/betas.html                          
Note:  For the most current plan, schedule, any questions or 
concerns, please contact the CICS ETP team at 
cicsetp@us.ibm.com for ISVs, or cicsep@uk.ibm.com for 
customers and customer beta info. 

● IBM "software early programs" (formerly BetaWorks and formerly 
Product Information Center):                           

● https://www.ibm.com/software/productintro/
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Appendix and Additional Information (cont.)

● University of Florida (UF):
● http://www.ufl.edu/

● UF CNS:
● http://www.cns.ufl.edu/

● CICS at UF:
● http://cics.ufl.edu/
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Presentation Information

● The Slackware Linux Project:                                               
http://www.slackware.com/ 

● OpenOffice.org "Impress":                                                 
http://www.openoffice.org/                                                     
(File -> Export as PDF)

● Lenovo X220 Ultraportable:                                          
http://www.lenovo.com/ 
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